What’s New in CreativeStudio™ Version 3.0.0

Gammill is pleased to announce CreativeStudio™ Version 3.0.0 which is available at: [http://www.gammill.net/index.php?m=statler_downloads](http://www.gammill.net/index.php?m=statler_downloads). Username and Password is available on the Statler User group. If you don’t have access to the Statler User Group contact support at 1-866-830-3738.

You must have Windows XP, with Service Pack 2 before attempting to install CS3.
To check click Start, right click My Computer, then click Properties. Check that under System you have at least Service Pack 2. If you do not please refer to the document located at [http://www.gammill.net/?m=statler_issues “How To Update Your Windows XP Service Pack”].

CreativeStudio™ upgrade instructions:
If you do not have an older CreativeStudio™ version installed, go to “CreativeStudio™ fresh install instructions” below.

- Download “CreativeStudio V3.0.zip”.
- Use Control Panel, Add Remove Programs to uninstall your old version of CreativeStudio.
- Move the downloaded file to your Stitcher and unzip it, run the CSsetup3.0.exe.
- If asked click “Install” KB958869, then click “Next”, then check “I Agree”, then check “Do Not Restart Now” and “Finish”.
- IF during the install you receive the following error “At minimum, you must have Service Pack 2 installed”, then please refer to “Setup Issue 1” found in the “Known Issues CS3 Document”.
- Follow the CS installation directions.
- Select your Controller (MOD) Type.
- Restart your computer.
- Start CreativeStudio™ and notice the introductory splash screen now indicates Version 3.0.0.
- Under the Tools menu item, select “Calibrate Stitcher” and follow the prompts to re-calibrate your stitcher.
- Under the Tools menu item, select “Controller Definition” and set your user defaults, such as SPI and tie length.
- You are now ready to run CreativeStudio™.

CreativeStudio™ fresh install instructions:

- If you have never had CreativeStudio™ installed on your computer you need to contact Gammill at 1-800-659-8224, ext 213 to purchase a version 3.0.0 CD. Or visit our website: [www.STATLERSTITCHER.com](http://www.STATLERSTITCHER.com), download the order form and fax to: 417-256-5757.
- You need to install from a CD at least once because the support files needed are very large and their installation is complex.
- The CD will auto install the many needed support files for you.
- If asked click “Install” KB958869, then click ”Next”, then check “I Agree”, then check “Do Not Restart Now” and “Finish”.

CreativeStudio™ v3.0.0 includes many new features and contains fixes that were suggested since the release of V 2.0. Many new enhancements have been added to improve the user’s experience. These enhancements came from quilters like you. If you have additional ideas for enhancements, please send them to enhancements@statlerstitcher.com. Gammill Quilting Systems and Statler Stitcher are committed to the needs of the quilting community and make every attempt to improve future software versions with their needs in mind. This release has been thoroughly tested. However, should you discover a problem with our software, please report it to support@statlerstitcher.com. Thank you.
**New Echo:**
Echo pattern creates a sewable echo at the designated distance. "Number of Echoes" allows users to set the number of times the pattern is echoed. Echo is primarily for echoing around the outside of a design. Echoing can even be placed inside a design by using negative numbers in the “echo spacing” box, but the pattern needs to be a fairly simple outline or an echo, for this to work effectively. Even open ended patterns echo.

*To use:* Right click on a pattern, and set the desired “Echo Spacing” (often .25”), as well as the desired number of times the pattern is to be echoed. Some patterns cause the echo to become” trapped"; these will provide only a partial echo and a message will advise the user to try a different “Echo Spacing”.

**New Divide:**
Divide pattern was completely rewritten. It now has the capability to divide text, as well as combined patterns, and at the Designer Pause. On longer arcs a divide node at the 90’ mark was added. To speed pattern editing, Divide stays active for multiple uses. Press Esc to exit Divide.

*To use:* Right click on a pattern and select divide pattern. Click on the node where you wish to divide the pattern. To divide another pattern just left-click that pattern and its divide nodes will be displayed. CS stays in divide mode until the user presses Escape or double clicks the CAD area.

**New Pattern Selection Methods:**
A selection window allows the user to drag a box around multiple patterns. If the window starts in a left corner, then the window must completely contain the pattern for it to be selected. If the window starts in a right corner then any pattern that intersects the window is selected.

*To use:* Left click in an open area of the CAD (not on a pattern), and then (while holding the left button down) drag a window around the patterns.

“Ctrl click” a selected pattern and it will be de-selected.

*To use:* Select as many patterns as desired or even all patterns on the CAD screen. If desired remove individual selected patterns by holding “Ctrl” and clicking on that pattern.

Use “< >” keys to cycle through patterns placed on your screen to make pattern selection easier.

*To use:* Sometimes it is difficult to select a small pattern segment or patterns that overlap on the screen. This new feature allows the user to use the < > keys to cycle through your patterns.

**New Pattern Manipulation:**
Several new relocate pattern tools have been developed to assist with pattern reuse, whole cloth quilting and with doing E2E in an alternative way.

“Shift Selected to 1 point”, moves any CAD point to any Quilt point.

*To use:* Select the pattern or patterns desired to move, then right-click, and select Relocate, Shift Selected to 1 point. The user will be instructed to click ANY CAD point, using the mouse, on the pattern being moved, and then click the corresponding point, using the sewing head, on the quilt. All selected patterns will be moved to match that one point, but the pattern will not be rotated.

“Shift All to 2 points”, moves any CAD point to any Quilt point, and rotates

*To use:* Right-click, then select Relocate, Shift All to 2 points. The user will be prompted to click two CAD points, using the mouse, on the pattern, and then click the corresponding two points, using the sewing head, on the quilt. All patterns will be moved and rotated to match these two points.

Now the user can “Reverse Pattern” in “Set Sew Order” by clicking the direction arrow, this will speed up pattern editing and straightening. This functionality is the same as “Reverse Start/End” but is faster, because the
user can use this technique at the same time they are changing the sewing order. This allows the user to immediately see the effect of the pattern direction changing.

To use: Press F8 to bring up Sew Order. If a pattern is going in the wrong direction, the user can now click the arrowhead (that shows the direction and end of the pattern) and the pattern will reverse.

The user may now “nudge” their pattern by using the ALT + Arrow Keys. This will move selected patterns by a small amount. The arrow key can either be tapped for a small move or held down for a steady move.

**New in Repeat Patterns:**
A Concatenation and Alternating function has been added to allow Repeat Patterns to setup an E2E.

To use: Setup up the Rows and Repeats or Total Width and Height as usual then “Select Alternating Type” and select “PlusRowOnTop” or “MinusRowOnTop” or “None”. This alternating does not automatically trim the sides like E2E does. If the user wants a trim, they will have to add it manually. Concatenation is just a matter of holding Ctrl while clicking the project patterns desired in the setup.

Repeat Patterns function has been reconstructed and its properties are more consistent and dependable.

The Repeat Patterns “Start End” control default has been changed to True. This makes it easier to connect a border into corners. The user does need to be careful if they are trying to fit patterns between a bounding edge. In that case, the user would probably want to turn Start End control to off.

An extra decimal accuracy has been added to Repeat Patterns Width & Height; this improves accuracy when using Repeat patterns for large quilts.

**New in CS:**
Competitive Tie-offs are now featured, which sew dense stitches with no backtrack. This was reviewed by the beta team as one of the top new features in CS3; these ties can now be the same as those that hand guiders use. **NOTE: This new feature is turned on by default. To use, click Tools, Controller Definition, then place a check by “Competitive Tie”. Competitive Tie is the default when CS3 is installed. The default setting Tie Stitches 6 to 8, and Tie SPI 33 to 43 yielded the best result. To turn off competitive tie remove the check in Controller Definition.**

“Pattern to Boundary” has been reconfigured to eliminate skewing and improve margins when using this feature.

“Project Stitch Count” is now included in “Project Details”, indicating the total number of stitches taken in the current project. The value is stored with the project so it can be referred to in the future as needed. It also tracks the regulated, constant, baste and Single Stitches. This is found in the project properties (yellow properties window). CS Total Stitch Count is in Controller Definition. This cannot be reset, other than by reloading CS or Restoring the Definition. This keeps track of stitches since CS was loaded.

Now “Channel Lock” & “Flip Angle” are remembered in Regulated, Constant, and Baste Modes, speeding up operation when the user has to use the same angle repeatedly. To use in Regulated mode, change the channel lock or flip angle and then exit; now when the user starts any of the hand guided modes, the angle set will show until it is changed.

The stitcher position is now shown in inches in the lower left corner. This value shows X & Y relative to the origin.

The user may now select multiple files from File Open. Click on “Add a Pattern”, to select multiple patterns listed consecutively, (such as a pattern set) click Add a Pattern, then hold shift and arrow down on the keyboard, then open. To select patterns that are not consecutive, hold Ctrl then mouse click each pattern. There is a limit of approximately 9 patterns depending upon the pattern name lengths.

You can now measure with your mouse on the CAD screen. To use click Alt + M or select Measure from the Draw menu, then click two points on the CAD screen. This feature works with both grid point and end point snap
and is especially helpful in Stand Alone Mode (SAM). The measured value can be transferred to any pattern property by right clicking the property.

E2E Settings are now stored and can be retrieved using the right click CAD menu. To use, right click in the open area of an E2E CAD screen and then select “E2E Settings”. This information is stored with the project and is often helpful for recovering.

There is a new added check for disconnected belts. In the past if the belts became disconnected there would be a dense pile of stitches on the quilt. Now CS watches while it is sewing for a belt that has come loose and provides a warning message.

F5 now clears the sewn pattern image. As the user moves patterns around, they may notice the “ghost” of the last sewn pattern; if this is bothersome, press F5 to clear it.

A new and different sound will be heard when pressing stop in a p2p line or pattern set-up. Now the stop sound is different than the OK sound helping the user use the sound to prevent user errors.

Rename quilt groups now using the right click CAD menu. To use select the quilt group that needs renaming then, right click on an open area of the CAD screen and enter the new name.

Endpoint snaps in Draw Arc and Curve now only snap when close to an endpoint. Before, it was necessary to turn end point snap on and off to connect an Arc or Curve to other patterns. Now, when drawing an arc or curve and the user is getting close to an endpoint it will automatically snap to the endpoint and when the user is not close to an endpoint there is no snap. This really speeds up drawing.

Previously if the user clicked New Project, then the Add Pattern dialog automatically came up. Advanced users like to be able to set a project’s properties before adding any patterns. Now New Project will only auto open the Add Patterns window if the “View Keypad Window” is checked in Controller Definition.

**Improved:**
Pattern manipulation is greatly sped up by a factor of 10.

Restart time is cut in half.

The default for Freeze Aspect is now “On” in most cases.

Removed tie off after restarting continuous patterns.

Crosshair now lines up with restart point.

End of pattern message now says “Cut bobbin thread”.

New updated warning form titles.

Thickened the crosshair lines and made them translucent.

Customer fields now have drop down text boxes.

Draw P2P Pattern no longer zooms to the last pattern drawn.

New updated motor numbers for Mod3 3934 & Mods A, B, & C to reduce thread breaks and aborts; this improvement has been very popular.

Changed Mod3 2135 & 3924 Default to old style belts, to help reduce Origin wandering, and it has been successful. Now if the user wants to sew belts off in a hand guided mode they will need to click the “AuxEncoders” button found in the upper left corner of the hand guided form. On these older systems it is suggested to keep ALL of the sewing belts on when sewing E2E or some other complicated project.
Extra Right click closes down each drawing function.

Improved E2E properties refresh

Improved accuracy of Sew Order clicks and scaling of sew order arrows

Right click now does not cycle thru patterns; whichever pattern that has been selected is the one that is selected by the right click menu.

Newly added message on exit asking if the user wants to exit CS, preventing an unintentional exit.

Fixed lingering user speed adjustment.

Fixed false speed value in status bar.

Fixed inset pattern distortion in Repeat Patterns & E2E.

Fixed inset pattern properties width update in Repeat Patterns & E2E.

Fixed spacing calculation in Repeat Patterns & E2E.

The name was changed from "Group All" text to "Select All".

Ctrl select a pattern will not deselect a pattern. If the user has already selected a pattern without Ctrl, then they must decide if they want to add more patterns to this selection group, press Ctrl and pick the additional patterns; the original selected pattern will remain selected.